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1 Overview

This Startup Guide provides the steps for connecting, configuring, and testing the 4000-OEM video
processing board. The 4000-OEM board provides the standard connections for power and
communication as well as general purpose 10 and camera connections.

For 4000-OEM software debugging capabilities see the 4000-DEBUG board in the ICD-4000-OEM. The
DEBUG board gives the developer access to a debug serial port at RS-232 level, a USB
programming/debugging port, and a switch/button combination for board recovery.

1.1 Additional Support Documentation

Additional Engineering Application Notes (EANs) can be found on the Documentation page of the
SightLine Applications website.

The Panel Plus User Guide provides a complete overview of settings and dialog windows. It can be
accessed from the Help menu of the Panel Plus application.

The Interface Command and Control (IDD) describes the native communications protocol used by the
SightLine Applications product line. The IDD is also available as a PDF download on the Documentation
page under Software Support Documentation.

1.2 SightLine Software Requirements

@® IMPORTANT: The Panel Plus software version should match the firmware version running on the
board. Firmware and Panel Plus software versions are available on the Software Download page.

2 Safe Device Handling

/\ CAUTION: To prevent damage to hardware boards, disconnect all input power to OEMs and adapter boards before
connecting or disconnecting cables including all FFC, FPC, KEL, HDMI, MIPI, and round wire (Molex) cables.

/\ CAUTION: To prevent damage to hardware boards, use a conductive wrist strap attached to a good earth ground.
Before picking up an ESD sensitive electronic component, discharge built up static by touching a grounded bare
metal surface or approved antistatic mat.

3 4000-EVAL Kit

Provides a complete laboratory bench/development interface with standard connectors. For additional
options and interface boards, please contact Sales. To review all the interface board options, see the
4000-OEM Accessories page on the SightLine Applications website.

The 4000-OEM wiill also support a number of USB Webcams and USB 3.0 Vision cameras.
Table 1: 4000-EVAL Kit

Part Number Qty |Description Part Number Qty |Description

4000-SOM 1 |Video processing board SLA-PWR-B12V-36W | 1 ;1)I2u\£ PA%V\;(:ASIZSE(IJVFJV/ 2p connector (36W)

4000-OEM 1 [REV A, PCBA SLA-CAB-0504 1 |5P PicoBlade to 3P Molex, and pigtail
Thermal pad pink 0.020-inch x

SLA-PAD-020-01 1 |1.63-inch x 0.010 inch with 0.5 x SLA-CAB-0804 1 |[8P PicoBlade to 3P (2) Molex, and pigtail
0.5 cutout

© SightLine Applications, Inc. 1
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(4000-EVAL Kit continued)

Thermal pad 1.4-inch x 1.6-inch x

SLA-PAD-010-01 1 0.010 inch SLA-CAB-0305 1 |TTL(3.3V) to USB serial cable w/ 3p Molex
4000-OEM-MP 1 |4000-OEM mounting base SLA-CAB-0402 1 |4p Molex to pigtail

4000-BRACKET 1 |4000-OEM heat sink bracket SLA-CAB-TC2USB 1 [USB3.0 Type-C to Type-A adapter
SLA-3000-HDSDI-IN 1 |HDSDI-IN Adapter board SLA-CAB-HD10 1 [HDMI output cable

SLA-DIST 1 |PWR/ENET distribution board SLO0852 1 |HDMI out adapter, female
SLA-KIT-4000-DEBUG | 1 |4000-DEBUG PCBA, kit SLA-MSD-ADPT 1 |SD adapter

SLA-CAB-0405 1 i4n-|cr;122%?;?3;}:2;?08@% 3:0 1 A-cAB-MCX2BNC | 1 |Cable, MCX (RA) to BNC(M) for HDSDI-IN
SLA-CAB-0404 1 f‘n'c';g?éeEXNt?v\'x‘OT'fx PicoBlade, 3.0 ¢ o cAM-HDSDI 1 |HD-SDI 1080p camera

SLA-MSD-32GB 1 |32GB uSD card (installed) SLA-PWR-A12V 1 |12V Power Supply for camera
SLA-CAB-1505 1 |4p PicoBlade to pigtail Mounting hardware | - |[Spacers and mounting screws

4 Hardware Bench Setup

® IMPORTANT: To prevent damage to hardware boards, disconnect the power before connecting or
disconnecting all cable connections.

Included boards:

« SLA-DIST: Provides power switch and standard bench interface connections for power and ethernet
connections.

o SLA-3000-HDSDI-IN: Provides camera interface to HDSDI cameras.

Cable connections:

« SLA-CAB-MCX2BNC: Connects to J1 (MCX jack) on the 3000-HDSDI-IN board and to the green BNC
connector of the 1080p camera.

The yellow BNC connector is for analog use only.

o SLA-CAB-0404: Connects to J3 on the SLA-DIST board and J4 on 4000-OEM. Provides Ethernet to
the 4000-OEM.

o SLA-CAB-0405: Connects to J50 on the 4000-OEM board and J2 on the SLA-DIST board. Provides
power to the 4000-OEM.

« SLA-PWR-A12V (110-250VAC input / 12VDC output): Connects to the red power connector on the
HD-SDI 1080p camera.

« SLA-PWR-B12V-36W (110-250VAC input / 12VDC output): Connects to J4 on the SLA-DIST board.
Power and network connectivity LEDs:

« Agreen light (D1) on the 4000-OEM indicates that all boards are powered on. An amber light (D5)
verifies network connection.

. To prevent voltage spikes to the board, plug in the power adapter to an AC power source first and
then connect to the board.

© SightLine Applications, Inc. 2
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@ IMPORTANT: Disconnect all input
power to OEMs and adapter Ve - 0 e SLA-PWR-B12V-36W
boards before connecting or [t

disconnecting cables.
________________ Network Switch or

r PC Direct
SLA-CAB-0404 (J4) R P RJ45 Ethernet Cable

**USB to Serial SLA-CAB-0305 (optional)

SLA-CAB-TC2USB (J8) SLA-PWR-A12V
USB 3.0 Type-C to Type-A Adapter

4000-OEM + SLA-3000-HDSDI-IN

........ HDMI OUT

* VSLAB000T5 Rev A

U HDSDI Input

(Green BNC

@ Contact Connector)
surface facing 1080p Camera
down when
inserting.
<s SLA-CAB-MCX2BNC
Optional Network LED (D5)

SLA-4000-MIPI Board
__________ 4000-DEBUG Board (see the ICD-4000-OEM)

Figure 1: Typical Bench Hardware Setup
*SLA-CAB-MIPI-02 FFC cable must be connected correctly. See FFC cable instructions before connecting the SLA-4000-MIPI board.

**SLA-CAB-0305 can connect to SLA-CAB-0804 to facilitate a PC/USB connection to serial port 0 on the 4000-OEM. See the Serial
Communications section for more information.

4.1 Additional SightLine Adapter Boards

SightLine adapter boards provide different I/O, camera inputs, or digital outputs. The boards can be
attached directly to the 4000-OEM or through a secondary adapter allowing customers to swap out
modules for custom configurations. This setup guide assumes the initial use of the EVAL kit only.
Customer specific configurations with other camera input boards are fully supported. See the EAN-
Digital Video Configuration for more setup and configuration information for supported cameras.

5 Network Configuration

The 4000-OEM Ethernet interface is configured for DHCP at factory default settings. No configuration is
necessary to acquire an IP address from a DHCP server. It will self-assign the link-local address of
169.254.1.182/16 if it does not receive a DHCP response.

Refer to EAN-Network Configuration for more network configuration information.

SightlLine recommends assigning a static IP on the PC when a DHCP server is not present on the
network.

If you require additional assistance with assigning a static IP address to the host PC, contact your
network administrator or search online for procedures that corresponds with your current PC
operating system.

© SightLine Applications, Inc. 3


https://sightlineapplications.com/wp-content/uploads/ICD-OEM-Camera-Side-Interfaces.pdf#page=3
http://sightlineapplications.com/wp-content/uploads/EAN-Digital-Video-Configuration.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-Digital-Video-Configuration.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-Network-Configuration.pdf
https://sightlineapplications.com/wp-content/uploads/ICD-4000-OEM.pdf

EAN- Startup Guide 4000-OEM \J

4000-OEM Board

Host PC
de m e e e - -> Network Switch -————— - -

Ethernet Cable RS s e S

User assigned static
IP: 169.254.1.10

Default IP assigned to the 4000-
OEM: 169.254.1.182

Figure 2: Network Configuration Options

5.1 Static IP Configuration Through Ethernet

1. Connect the board to a DHCP network.

2. Apply power to the 4000-OEM and wait for the board to receive an address from the DHCP server.
3. Connect to the board in Panel Plus.

4. Configure a static IP address using the procedure outlined in EAN-Network-Configuration.
Configuration notes:

- If a wireless adapter is active on the host PC it should be disabled.

« If using the link local address, we recommend assigning a static IP address to the host PC of
169.254.X.X, where X is 1-254 (do not use 182). Use a subnet mask of 255.255.0.0.

. Problems with outbound streaming are often related to setting/assigning IP addresses and ports.
See the Encoding Configuration settings in EAN-Encoding for advanced settings.

6 Serial Communications

Use a direct serial connection for troubleshooting or if a network connection cannot be established.

To connect to a PC USB port, attach the USB to TTL (3.3V) serial cable (SLA-CAB-0305) to SLA-CAB-0804
to J25 (Serial 0) on the 4000-OEM board (Figure 3). Serial ports on the 4000-OEM are 3.3V TTL.

3-pin Connector SLA-CAB-0804 : 4000-OEM
-----**--------- |
. |
SLA-CAB-0305 Serial 0 ]

|
|
|
|
|
I o
USB to PC* ‘--------- -*125(81"") :
|
|
|
1

*See the USB Device Driver i Serial 0
section below. <= - !

Figure 3: )25 Serial 0 to PC Connection (SLA-CAB-0804)

6.1 Direct Serial Connection (optional):

1. Connect the serial cable to the 4000-OEM board e Boards ()
and host PC as show in Serial Communications. oo 7] [

2. From the Connect tab, click the Refresh List button =
to get a list of available COM ports. (cick to connect)

PeuUaD

ssaddwony

3. Select the Com portin the drop-down menu. Figure 4: Direct Serial Connection

Click the Disconnected (click to connect) button.

© SightLine Applications, Inc. 4


http://sightlineapplications.com/wp-content/uploads/EAN-Network-Configuration.pdf
http://sightlineapplications.com/wp-content/uploads/EAN-Encoding.pdf

(ﬁ~
EAN- Startup Guide 4000-OEM @

6.2 USB Device Driver

If the USB connection on SLA-CAB-0305 is not functioning correctly a third-party driver may be needed.
The driver can be found on the Silicon Labs web page » Downloads tab » CP210x Universal Windows
Driver. Once installed open the Run window in Windows (WIN+R) and enter devmgmt.msc to open the
Device Manager. Verify the new driver is listed under Ports (COM & LPT) as shown in Figure 5.

v B Ports (COM & LPT)
» i Silicon Labs CP210x USB to UART Bridge (COM7)

Figure 5: CP210x Universal Windows Driver Installed

7 Panel Plus
This section covers the Panel Plus setup and configuration process. Panel Plus provides a basic
graphical interface to the 4000-OEM board.

Before connecting with the Panel Plus software, the 4000-OEM board should be powered up and
connected through:

- anetwork switch or directly to the host PC (preferred) or,
- Direct serial connection (for troubleshooting or if a network connection cannot be established).

1. Go to the Software Downloads page on the SightLine website and download the Panel Plus
application installer. Older releases are available under the Previous Versions section.

@ IMPORTANT: The firmware version number and Panel Plus Software version number should match.
If the board firmware version is initially unknown, reference the SightLine invoice that came with
the board when it was purchased.

Launch the installer file and follow the prompts. After installation, open the Panel Plus application.

The first time that Panel Plus is launched, a Windows Security Alert prompt should appear. Select
Allow Access to create a firewall exception (Figure 6).

Approving private network access is sufficient in most cases. Check public networks if directly
connecting to the board.

@ Windows Security Alert H

Windows Defender Firewall has blocked some features of this

app

Windows Defender Firewall has blocked some features of slapanelplus. exe on all public and
private networks.

@ Mame: apanelplus.exe

Publisher: Unknown
Path: C:\Program Files (x86)\sightline applications\sla-panel-plus
3.05.03\slapanelplus.exe

Allow slapanelplus.exe to communicate on these networks:
- Private networks, such as my home or work netwark

[J Public netwarks, such as those in airperts and coffee shops (not recommended
because these networks often have litle or no security)

What are the risks of allowing an app through a firewall?

» G.ﬂ_llow access Cancel

Figure 6: Windows Security Alert Prompt

© SightLine Applications, Inc. 5
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@ IMPORTANT:

« Do not cancel this prompt. Failure to allow access at this point will not allow the Panel Plus
application to connect to the board. See the Troubleshooting section for more information.

. Before using the Panel Plus program, review the Panel Plus User Guide in the Help section of the
Panel Plus application for additional user and setup information.

4. Network connection to the board:
a. From the Connect tab, click the Refresh List button to get a list of boards on the network.
b. Select the appropriate board in the drop-down menu.
c. Click the Disconnected (click to connect) button.

Once the connection is

Connected Board: 14001

successful, the button {dlick to disconnect) PC: 14002
changes to Connected.

Figure 7: Network Connection to the OEM Board

5. Verify the connection.

Video Output:

When the Panel Plus has Cam D | | HDMI & Net ¥
successfully connected to
the 4000-OEM board, Stream Netnork Advanced IP...
operating information is
displayed under the Video Firmware Ver: 3.5.3.30 FGPA: 00:00, HW Rev:02, temp: 125°F [37°C]
Output section and the SVN Revision: 69395, Build Date: 08/09/2022, Build Time: 09:24:54 L7l
bottom status bar in Panel Enabled Features (.« if licensed ):
Plus. If the connection was App Bits: OXOFFFFFFF ~PEE
not successful, this Stabilization Blending rgatrulrlztsed
information will not be Full Tracking Enhancement
present or incomplete. Full Telemetry Focus Telemetry

@ IMPORTANT: For optimal Detection - Base [ Tracker Only - Advanced
performance, monitor the Detection - Advanced HD 720 Input
board temperature. Board IF Encoding H264 HD 1080 Input
temperatures should be H265 Encoding HD 4K Input
below 185°F (85°C). To KLV HD 720 Output
keep boards within the Recording / Snapshot HD 1080 Cutput
optimal temperature Precision Landing HD 4K Output
range, use the included
heatsink during bench NUC and DPR Dual Processing
testing. For more High Bit Depth Enhancement Advanced
information about thermal Classifier
management see the ICD-
4000-OEM. Figure 8: Firmware Version and Enabled Features

© SightLine Applications, Inc. 6
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7.1 Camera Acquisition

1. From the main menu go to Configure » Aquisition Settings. This dialog window allows changes to
the camera configuration.

2. Setthe Camera Index to Cam 0. Set the Camera Type to Generic Digital.

{’} Acquisition Settings

Camera Index: Cam 0 '

Camera Type: |Generic Digital e

3. Inthe AutoFill drop-down menu, select HD-SDI 1080p30 from the Auto Fill menu or enter the
Height and Width settings of the connected camera.

If using a camera that is not configured for 1080p30, choose a corresponding option under Auto Fill
that matches the camera, e.g., HD-SDI 720p or HD-SDI 1080p60.

If the camera is listed, the AutoFill drop-down menu automatically populates the relevant fields with
the correct settings as shown in Figure 9.

Generic Digital Settings

Auto Fill ~

Height | 1080 |4 Width Resulting Flag Bits 0x801
Vertical Front Porch; Horizontal Front Parch: Bit Depth;

Input: () Gray Scale (® YUV color () G8 16bitin () Bayer () Laser [ | Interlaced [ | Byte Swap

[] tnvert v-Sync Polarity [ ] Invert H-Sync Polarity [ JUB0  [] 2xhin  Sync/Crop: |Embedded Sync

Camera Init Code: | Mone w
Options: |
Big: Height 0 > Width 0 +  Vertical Blanking 0 +  Horizontal Blanking 0 S

Figure 9: Camera Acquisition Auto Fill Settings Example - HD-SDI 1080p30
4. After changes have been made, the Apply button will turn red indicating that a change has been
detected. Click Apply to apply the changes. Close the Acquisition Settings dialog window.
5. Save and activate the settings:
a. Main menu » Parameters » Save to Board.
b. Main menu » Reset » Board.

c. After the system reboots reconnect to the board. Make sure the board connects.

See EAN-Camera Compatibility for all third-party cameras and lens assemblies that are currently
supported by SightLine software. Includes configuration and setting support guidance.

© SightLine Applications, Inc. 7
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7.2 Stream Network Video to This PC

To stream network video to the connected PC, click the Connection tab in Panel Plus and then click

Stream Network Video to this PC.
Video Qutput:

Cam 0 | HDMI & Net

Stream Metwork
Video to This PC

Advanced IP...

Figure 10: Stream Network Video to PC

8 Summary

This completes the startup guide for the 4000-OEM board. See the Panel Plus User Guide (main menu »
Help » User Guide) for additional user and setup information.

If the board has been connected to a camera and encoding functions are part of the configuration,

video will be displayed in the main window. On the Connect tab of Panel Plus, the purchased/enabled
functions are checked. To add additional features to 4000-OEM, contact Sales.

To modify the encoder parameters of the OEM, see the Modifying Encoder Parameters section.

G SightLine Applicaticns Panel Plus [3.5.3.63393] - X
File Parameters Reset Configure Video View Customize Help Panel Plus
4 User Guide
Command Camera(s)
Cam 0
SightLine Boards (2} o
SLA4000_Se2al2, 169.254.1.182 ~ Refresh List %
2
Connected Board: 14001
{dlick to disconnect) PC: 14002 a
o
3
Video Output: %
Cam 0 ~ | | HDMI & Net @
Stream Network F4
Video to This PC Advanced ... g
Firmware Ver: 3.5.3,30 FPGA:00:00, HW Rev:02, Temp: 111°F [44°C]
SVN Revision: 63395, Build Date: 08/09/2022, Build Time: 02:24:54 é.‘
Enabled Features (v if licensed ): £
Enabled App Bits: 0x0FFF7FFF °
Features Stabilization Blending o
Full Tracking Enhancement n::f
2
Full Telemetry Focus Telemetry °
Detection - Base [ Tracker Only - Advanced =
=
Detection - Advanced HD 720 Input =3
TP Encoding H264 HD 1080 Input -
H265 Encoding HD 4K Input 2
=4
KLV HD 720 Output
Recording / Snapshot HD 1080 Output =)
4
Precision Landing HD 4K Output o
NUC and DPR Dual Processing
. - Q
High Bit Depth/Temp Telemetry Enhancement Advanced =
-] i 7}
73 3 Classifier g
received: CurrentEthernetVideoParameters 51,AC,0C,48,50,00,01,01,80,00,00,00,00,00,65 ~ Dema Mode -
received: StreamingControl 51,AC,04,90,0F,00,98 Demo Mode g
received: VideoDisplay 51,AC,08,A4,00,00,42,00,05,00,A9
received:VideoDisplay 51,AC,08,A4,01,FF,00,00,05,00,B0
received:MultiDisplay 51,AC,04,A5,00,00,00,00,00,18,02,00,78
received: CurrentvideoParameters 51,AC,04,46,00,00,00,00,00,00,00,00,50
received: CurrentDisplayParameters 51,AC,13,57,00,00,00,00,00,01,40,00,00,00,00,00,00,04,00,00,00,38
received: CurrentDisplayParameters 51,AC,13,57,00,00,00,00,00,01,40,00 IJ[],DIJ,IJD,D1,IJD,D4,[]D,IJIJ,DD,IJC
received: CurrentDisplayParameters 51,AC,13,57,00,00,00,00,00,01,40,
received:CurrentDisplayParameters 51,AC,13,ST,DD,DU,DD,UD,DD,U1,40,UD,00,DD,00,03,00,04,00,00,00,62 ( S I g h t L I n e
received: Currenﬂ?nrﬂ:nnﬁguraunn 51 AC ]q 53,00,00,00,00,00,00,00,04,00,00,00,00,00,00,00,00,00,00,65 )
received:StreamingControl 51,AC,04,90,0F, 00,58 v APPLICATIONS
Board: SLA4000_5e2a12, 169,254, 1,182 Firmware Ver: 3.5.3.30 FPGA:00:00, HW Rev:02, Temp: 111°F [44°C] | Streaming Camera: 0. Commanded Camera: 0 KLV rate: 27.61[Kb/sec]
SVN Revision: 63395, Build Date: 08/03/2022, Build Time: 02:24:54 This PC: 169.254.254.205 Frame Rate: 30.28[frames/sec]. Data rate: 5986.06[Kb/sec] R
Figure 11: Panel Plus Connection to Board
© SightLine Applications, Inc. 8
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@® IMPORTANT: Not all 4000-OEM purchased configurations include encoded IP video. For
configurations that include encoding, video will be displayed in the Panel Plus main window.
Tracker-only configurations will display processed video on the HDMI output only. An HDMI-
capable monitor is required for viewing this output.

8.1 Demo Mode

To enable all features for testing and evaluation purposes, click the Demo Mode button from the
Connect tab. All the features enabled on the board are now available for testing. The Demo Mode
screen overlay will display until the Demo Mode function is turned off.

9 Modifying Encoder Parameters

The encoder parameters can be Netwark 0 v
modified from the Compress tab in CODEC [ TRANSPORT
Panel Plus. RTP: MIPEG
. The H.264 encoding option is a 8 EE :'i: 8 EE :E:ig :'i:
good choice to get started. : el
] ) MPEG2-TS: (® H.264
- Inthe Output Properties section, O H.265

use the default values for Frame
Step and Down Sample.

[ ] Pad UDP packets so all packets are the same size (MPEG2-TS only).
QOutput Properties

Frame Step:

. The Streaming parameters Down Sample: | Mone
section defines the destination Output Frame Size: | Qut=In “
IP address and port. Quality: 80
. To set the parameters quickly, Foveal: 0
click the U§e My IP - Unicast 4. 264 Profile: High »
button. This sets the outbound _ =
o Bit Rate: 6,000 + | Mbps]
destination IP address to the =
. I-Frame Interval: |3IZI = |[frames]
network interface card on the =
pC Block Refresh: 0 + | blocks]
' Slice Refresh Size: |III S |[r|:|ws]
« Click Send to dynamically set the Deblocking: Filter all edges ~
desired IP Address, UDP Port, Bit Rate Contral: Variahle ~
and UDP delivery format S
(Unicast, Multicast, or Streaming

Broadcast).

. To save the settings and make

To IP Address | 192.168.0.31

~|  Port|15004

Broadcast

Use My IP - Unicast Use Multicast

the.m recurrent through restarts, Send Stop Streaming [ Start/Stop All Nets
main menu » Parameters » Save
to board. Export SDP File... | |Stream RTSP URL
Statistics
See EAN-Parameter File for a Frames 0.00  [1fsed] Video 0.00  [Kbfsed]
. . . Profile: M/ KLV 0,00 [kb/sec]
comprehensive guide to saving Encapsulation: Codec:

parameter settings.

© SightLine Applications, Inc.
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10 Troubleshooting

Issue: Unable to connect with the Panel Plus application to the 4000-OEM over a standard network
connection.

Check static IP address:

Check the static IP address configuration. Improper or unknown static IP address setup is a common
connection problem. See the Network Configuration section and EAN-Network Configuration for more
network configuration information.

Check Windows firewall:

Failure to allow access in the Windows Security Alert dialog during initial startup of the Panel Plus
application can cause connection issues.

1. Close the Panel Plus software application and open the Windows Firewall Security Manager on the
host PC.

2. Goto Inbound rules and delete the two slapanelplus rules (TCP and UDP).

@ Windows Firewall with Advanced Security - O X
File  Action View Help
ol A i (HEN 7

3 Inbound Rules Mame Group . Profile Enabled  Action || Inboun.. & *
&Y Outbound Rules
al',l_- Connection Security Rules @ Cyberlink PowerDVD 12 DMREngine All Yes Allow w1l Me.
B Monitoring 0 Cyberlink PowerDVD 12 Media Server Ser... All Yes Allow T Fit. »
@ Cyberlink PowerDVD12 All Yes Allow
@ Cyberlink PowerDVD12 Agent All Yes Allow Y Fit.. ¥
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Figure 13: Windows Firewall Security Manager Fire - Delete Inbound Rules
3. Re-start the Panel Plus application and allow access in the Windows Security Alert prompt window.
Check hardware connections:

Make sure that all the boards are powered on. If connecting over the network, switch to a direct serial
connection. See the Serial Communications section. The Panel Plus software will automatically
recognize serial ports and list them in the drop-down menu for available connections.

Connecting to the serial port on the 4000-OEM board from a host PC requires TTL (3.3V) to USB
serial cable w/ 3-pin Molex cable (SLA-CAB-0305).
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Check network configuration:

After communications have been established using the serial connection, networking settings can be
corrected to allow proper network communications.

1. From the main menu, go to Configure » Network Settings.

2. If an unknown static IP address is assigned, remove it or update it to match the addressing scheme
of your network.

€} Network Settings — O =

Set | ethd *  network parameters,
Use Static IP

1
| IP address 132 . 4 . 7 . 181 |
1
: 1 Check network
: Subnet 255 . 255 . 0] . i) . settings
1 1
! Gateway 132 . 4 . 7 . 1 X
Command and Control Port |1£HZIEIE | [14007]
Host Mame: | | (Clear to reset)
Send

Figure 14: Check Network Settings

10.1 Send Diagnostic Files to SightLine Support

In the event of a system malfunction or other issue, use the Get Diagnostic Files feature in the
SightLine upgrade utility application to download files and then send them to Support.

) SLA - 4000 Upgrade Utility - ] X
File | Help

License File v kmctury: C:\Program Files (x86}\SightLine Applications\SLA-4000 Upgrade Utiity 3.05.03\fimware
Pararneter File » B5330 SVN Revision: 65335 Build Time: 2022/08/03 02:24:54
Program Files L4 Name IP Address Version SWN Revision Date Time HW Rev Appbits
SER RN I sT24000 3b114c 192.1658.1.150 3.5.3.30 £9395 2022/08/09 02:24:54 ———  (OxDEEETEEE
User Logo File [
Advanced * Get Diagnestic Files... |

Put File... | |

Get diagnostic files from hardware as a zip file and save it to PC.
IP Addres Get File.. 9 ! P I
Reset Board (reboot) #] Remove Parameter File
Set IP Address...

Figure 15: Get Diagnostic Files
Additional diagnostic information can also be obtained from the 4000-OEM by displaying the system
log.
1. Establish an SSH session to the OEM with Tera Term (recommended) or similar application.
2. Login using the default username and password for the 4000-OEM: slroot
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3.

4.

At the prompt, type:
dmesg
Copy the output and send it to Support.

10.2 Nonfunctional SLA-4000-MIPI-IN Board (4000-MIPI-IN Kit)

I12C Bus 3 detect can be used to help diagnose issues with ports and/or cable connections on the SLA-
4000-MIPI-IN board.

1.
2.

®

5.

Remove all the adapter boards from the 4000-OEM.
Establish an SSH session to the 4000-OEM with Tera Term (recommended) or similar application.
Username and password: slroot

Run command: i2cdetect -y -a -r 3. The status of the SLA-4000-MIPI-IN board in Tera Term is shown
in Figure 12.

Functioning and Connected Correctly Not Functioning and/or Connected Correctly

Bzlroot B ™
i2cdetect —y —a —-» 3
a1 2 3 4 5 6 7 8 % a b c d e f
uu —_— = == == == == == == =
uu —_— = == == == == == —= -

Figure 16: 12C Bus 3 Detect with Tera Term

If nothing shows up using 12C Bus 3 detect, check the SLA-CAB-MIPI-02 cable connection between
the SLA-4000-IN MIPI board and the 4000-OEM, and then repeat steps 1 through 3.

IMPORTANT: To prevent damage to hardware boards, disconnect the power before connecting or
disconnecting the SLA-CAB-MIPI-02 cable.

If the board is still not responding contact SightLine Support.

10.3 Questions and Additional Support

For questions and additional support, please contact SightLine Support. Additional support
documentation and Engineering Application Notes (EANs) can be found on the Documentation page of
the SightLine Applications website.
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